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C H A P T E R  1  

Introduction 

The PrimeWorks® software allows a user to manage, graph, and report logger 
data and to program and retrieve data from loggers.  It also provides various 
database management tools and functions. 

PrimeWorks primarily offers or supports the following features and products:  

 Database Management 

 Report Generation 

 Graphing 

 PrimeLog® 

 PrimeProbe®2 

 Mobile Device Interface 

 Automatic and Manual Data Importing and Exporting 

 
PrimeWorks software 
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 Technical Support 
ADS provides technical support services for assistance in configuring and 
operating the PrimeWorks software.  Contact the ADS Support Center by 
telephone or email in the following way:  

 (877) 237-9585 

 adssupportcenter@idexcorp.com 

mailto:adssupportcenter@idexcorp.com�


ADS PrimeWorks User Manual 

3 

C H A P T E R  2  

Software Installation 

This chapter provides the hardware and software requirements for running the 
PrimeWorks software on a user’s PC and instructions for installing the 
software.  
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Hardware/Software Requirements 
The user’s PC must meet the following hardware and software requirements to 
run PrimeWorks.  However, please keep in mind that, as with any software 
application, software performance typically increases with stronger host system 
specifications. 

Hardware Requirements 
The user’s PC must satisfy the following minimum hardware requirements to 
run PrimeWorks: 

 Intel® Pentium® 3 or equivalent CPU 

 128 MB RAM 

 10 MB available hard disk space 

 Serial communication port (for programming or reading data from 
loggers) 

Software Requirements 
 Microsoft® Windows® 2000, Windows XP, or Windows Vista® (32-bit) 

 .NET framework (included as part of the PrimeWorks installation) 

Note:  ADS does not provide technical support concerning issues 
relating to, or caused by problems with, the operating system installed 
on the user’s PC. 

User Access Requirements 
To install PrimeWorks, the user must have the appropriate administrative 
privileges to write to the Registry. 
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 Installing PrimeWorks 
Note:  PrimeWorks uses the .NET framework.  Therefore, it must 
reside on the user’s PC before the PrimeWorks software can be 
installed.  If .NET does not already exist on the user’s PC, the 
installation CD will initiate .NET installation automatically.  

Note:  The installation process provides the option to designate the 
folders in which to install PrimeWorks.  However, ADS recommends 
using the designated default folders. 

Install the PrimeWorks software in the following way:  

Note:  Do not run any other applications during the installation 
procedure. 

1. Insert the PrimeWorks installation CD into the CD-ROM drive.  The 
installation CD has an AutoPlay feature that should run the CD 
automatically.  However, if this does not occur, run the CD in one of the 
following ways: 

 Select Start > Run, enter [CD-ROM drive 
designation]:\setup.exe, and then click OK. 

 Navigate to the ADS Primework Setup.exe file on the CD through 
My Computer or Windows Explorer, and then double-click on the 
file. 

2. Click Yes to initiate the installation process, or No to cancel. 

3. Proceed through the installation wizard, supplying the appropriate 
information as requested. 

Note:  If necessary, the .NET framework will be installed 
automatically.  Please allow several minutes for this to occur.  The PC 
may appear to be hung during installation.  Once .NET installation is 
complete, the user must repeat the PrimeWorks installation process.  

4. Restart the computer upon request.  This typically is required only after 
.NET framework installation. 
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C H A P T E R  3  

Interface Overview 

The PrimeWorks user interface enables a user to perform many functions, 
including data management, graph and report generation, logger programming, 
and data retrieval (i.e., readback).  The interface is similar to Windows and, 
therefore, should be visually and functionally familiar for most Windows users.  

This chapter describes the basic layout of the PrimeWorks interface and 
provides a general overview of the interface components and features. 
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 Main Window 
The main window of the PrimeWorks user interface is comprised of three 
main sections:  

 Menus and Toolbar 

 Database Navigation Pane 

 Viewing/Working Pane 

 
PrimeWorks main window 

The user can drag the vertical divider located between the database navigation 
pane (left) and the viewing pane (right) to the right or left to change the sizes of 
the two sections.  However, ADS recommends maintaining a larger portion for 
the viewing pane to optimize the presentation of information. 

Menus and Toolbar 
The menus and buttons on the toolbar control various software functions 
described in detail in subsequent chapters.  

Database 
Navigation Pane 

Viewing/Working Pane 

Menu 
Toolbar 
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Database Navigation Pane 
The database navigation pane provides a graphical representation of the 
database.  The hierarchical tree structure places the database name at the top 
level and the individual loggers at the lower levels.  

 
Database Navigation Pane 

The expansion symbol (+) indicates that additional items are contained, but 
currently not visible, under the main heading.  Clicking on this symbol reveals 
these contents.  Expanded contents can be hidden by clicking on the hyphen (-). 
The user can highlight items in the display to determine the starting point of the 
data cascade for reporting and graphing and delete or rename items by right-
clicking and choosing the appropriate menu option. 

 Right-Click Option Menu 
The right-click menu available through the database navigation pane displays 
when the user right-clicks an item in the database. 
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Right-click option menu (the content on the menu depends on the database item selected) 

Note:  The options available on the menu depend on the plug-ins 
loaded during the software installation process and the type of logger 
selected.  

The following table describes the functions typically available on the menu: 
Menu Item Function 

Automatic Export Selecting this option adds the selected item (and the 
contents below it in the tree) to the Automatic Export 
dialog opened in the viewing pane of the main window. 
See Automatic Export on page 30 for more information. 

Export Data Selecting this option adds the selected item (and the 
contents below it in the tree) to the Export Data dialog 
opened in the viewing pane of the main window. See 
Export Data on page 32 for more information. 

Graph Selecting this option graphs the selected item (and the 
contents below it in the tree) on the Graph dialog 
opened in the viewing pane of the main window. See 
Graphing on page 59 for more information. 

Program Selecting this option launches the appropriate logger 
program screen to enable the user to program the 
selected logger. 

Report Selecting this option adds the selected item (and the 
contents below it in the tree) to the Report dialog 
opened in the viewing pane of the main window. See 
Reporting on page 69 for more information. 

Rename Selecting this option highlights the name of the selected 
item and places it in an editable field, allowing the user 
to modify or change the name as necessary. To cancel 
the rename or confirm changes to the name, click on 
another item in the browser control window. 

Delete Selecting this option deletes the selected item (and the 
contents below it in the tree) following a confirmation 
dialog.  Clicking OK deletes the item; clicking Cancel (or 
closing the window) cancels the deletion.  

Working/Viewing Pane 
The Working/Viewing Pane displays application dialogs for setting various 
parameters and viewing output data, such as reports and graphs.  
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C H A P T E R  4  

Menus 

This chapter describes the options available within the menus listed along the 
header portion of the PrimeWorks main screen:  

 File 

 Import/Export 

 Database 

 Mobile Device 

 PrimeLog 

 PrimeProbe2 

 Report 

 Help 

It also defines the buttons used for resizing, closing, minimizing, or maximizing 
the application window.  
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 Standard Windows Buttons 
The following table provides descriptions for the buttons used to manipulate the 
application window:  

Button Function Description 

 
Minimize Clicking on this button minimizes (or hides) the window.  

The user can re-open the window by clicking on the 
PrimeWorks button on the taskbar.  PrimeWorks remains 
running while the window is minimized.  The Minimize 
option also is available by right-clicking on the title bar.  

 
Maximize Clicking on this button expands the window to fit the entire 

screen.  The Maximize option also is available by right-
clicking on the title bar. 

 
Restore Clicking on this button scales down the size of the window.  

When the window is in this state, the user can click and 
drag the edges and corners of the window to resize the 
window as required.  Clicking and holding the header (i.e., 
title bar) with the window in this state allows the user to 
drag the application window around the screen as 
necessary.  The Restore option also is available by right-
clicking on the title bar. 

 
Close Clicking on this button closes the window and terminates 

the program to which the window belongs.  The Close 
option also is available by right-clicking on the title bar. 
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 File Menu 

 
File Menu options 

The File menu includes the following submenus:  

 Print, Print Graph, or Print Report 

 Print Preview 

 Page Setup, Graph Page Setup, or Report Page Setup 

 View 

 Properties 

 Exit 

Print 
The Print menu option displays the Print dialog for the default Windows 
printer and allows the user to select print options such as the number of copies, 
page setup, finishing details, orientation, and paper type.  The options available 
on the dialog reflect the capabilities of the printer.  The dialog also allows the 
user to select other printers, when applicable.  

Print Preview 
The Print Preview option displays an on-screen representation of what the 
selected graph or report will look like upon printing.  This allows the user to 
verify the output before final printing.  
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Print preview window 

From the preview window, the user can send the items to print, select the 
number of pages to preview at one time, magnify or reduce the size of the data 
presented on the screen for viewing, or close the preview window without 
printing the items. 

Page Setup 
The Page Setup option controls the output format of PrimeWorks, allowing 
the user to modify settings for generating reports and graphs.  For the best 
results, ADS recommends selecting the landscape mode for printing graphs and 
the portrait mode for printing reports.  
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Page Setup dialog 

The top part of the dialog displays a typical sample page with text and borders 
indicated by dotted lines.  This sample page dynamically reflects any changes 
to the page settings made by the user. 

Note:  The paper size and source options available are based on the 
default printer designated through the Printer dialog in the Windows 
Control Panel.  Windows XP users typically can set this through the 
Start > Settings > Control Panel > Printer and Faxes options.  Refer 
to the corresponding Windows documentation to access this location 
through other Windows versions and configurations. 

View 
The View menu includes two options:  

 
View options 
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 Database 
This option serves as a toggle button to show or hide the database navigation 
pane on the main screen.  A check symbol () displayed beside the Database 
option on the menu indicates the database currently displays on the main 
screen.  Selecting this option (removing the check) hides the database.  

 Messages 
This option serves as a toggle button to show or hide the Messages dialog.  
Once displayed, the user can close the dialog by either clicking on the close 
button on the dialog or selecting the Messages option on the menu.  

Properties 
The Properties option displays the Properties dialog.  

 
Properties dialog (General tab) 

The following tabs allow the user to select the individual properties: 

 General 

 Ftp Setup 

 Graph 

 SMS Messaging 

 PrimeLog 

 PrimeProbe2 

 Automatic Backup 
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 General 
This tab displays the current database location.  The user can designate an 
alternate location by clicking on the Browse button and navigating to the 
desired path.  Once the path has been selected, the new path will display in the 
Database Path field on the Properties dialog. 

To implement the new path for the database, click on the Apply button.  Click 
on the Cancel button to retain the current database path. 

 Ftp Setup 
This feature is currently unavailable. 

 
Ftp Setup tab 

 Graph 
This tab displays the graphing properties indicating the current graph settings.  
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Graph tab 

From this location, the user can change the colors of the graph titles, axis, and 
trace (i.e., data); designate titles for the graph and time axis; indicate whether to 
display an optional grid on a graph; and designate whether to increase the 
thickness of the trace. 

After making the necessary selections or modifications, click on the Apply 
button to institute the changes or the Cancel button to ignore the changes. 

 SMS Messaging 
This tab displays the necessary parameters for performing Internet 
communication or wireless GSM (Global System for Mobile Communications).  

 
SMS Messaging tab 
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After making the necessary selections or modifications, click on the Apply 
button to institute the changes or the Cancel button to ignore the changes. 

 PrimeLog 
This tab displays the media and hardware through which communication will 
occur and the corresponding parameters.  

 
PrimeLog tab 

 Default Comms Media 
This section indicates the kind of connection:  Local (cable) or Modem 
(remote). 

 Port 
This field identifies the communication port to which the logger will be 
connected when using the PrimeLog functionality.  Select the appropriate port 
from the drop-down list.  This list contains only those ports that are currently 
available for selection. 

 Select Modem 
This field indicates the modem through which communication will occur.  
Select the proper modem from the drop-down list.  This list contains only those 
modems available on the PC.  This option is available only when the Modem 
option is selected.  

 Location 
This field specifies the PC location for dialup.  Select the appropriate option 
from the drop-down list.  Clicking on the Properties button allows the user to 
select locations and dialing rules using the standard dialing functions in 
Windows.  This option is available only when the Modem option is selected. 
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 Receive Alarm Calls 
This option switches the PC modem into the proper mode for the system to 
receive a call from the logger.  This option is available only when the Modem 
option is selected.  

 PrimeProbe2 
This tab provides the Port drop-down list from which to select the proper port 
for the PrimeProbe2 connection.  

 
PrimeProbe2 tab 
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 Automatic Backup 
This tab enables the user to select a time (daily) at which to copy the backup 
data and designate a database location in which to store the backup data.  

 
Automatic Backup tab 

After selecting the time to make the copy and browsing to the directory location 
in which the data should be stored, click on the Apply button.  Click on the 
Cancel button to exit the Properties dialog without saving any changes.    

Exit 
This option exits the PrimeWorks software.  The user also can exit the 
software by clicking on the standard exit button ( ) at the top right-hand 
corner of the PrimeWorks application window.  
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 Database Menu 
The options available under the Database menu may vary based on the item 
selected in the database navigation pane.  The following sections display the 
possible menu options and descriptions for the options.  

Item Selected in Browser Control Available Database Menu Options 

Database 

 

Group 

 

Sub Group 

 

Site 

 

Logging Function 

 

The following sections offer descriptions of the Database menu options. 
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Delete 
(Includes the Delete, Delete Group, Delete Sub Group, Delete Site, and Bulk 
Delete options)  

The delete option deletes the database items selected in the browser control.  
Any items included within the selected item also will be deleted.  The Bulk 
Delete option allows the user to delete several or all items from the database at 
one time. 

Rename 
(Includes the Rename Group, Rename Sub Group, and Rename Site options) 

The rename option places the selected database item into an editable mode for 
modification as necessary.  

Bulk Move 
This option displays the Bulk Move dialog that enables the user to move 
multiple items from one group or sub group to another group or sub group in a 
database at one time.  

 
Bulk Move dialog 

Perform a bulk move in the following way: 

1. Select the checkboxes corresponding to the sub groups and/or sites for 
transfer from the Select Sites to Move box on the Bulk Move dialog.  
PrimeWorks also provides the option to select all items for transfer at 
one time by selecting the Select All checkbox. 

2. Select the group or sub group to which to move the item(s) from the 
Select Destination Group box.  The group or sub group to which the 
item is moved must in a higher position on the database hierarchy than 
the item undergoing transfer.  It cannot be in a lower or equivalent 
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position.  For example, a sub group (with its associated sites) can be 
transferred from one group to another group, but not to another sub 
group.  To transfer all the sites from a specific sub group to another sub 
group, select the checkboxes for all the sites individually, without 
selecting the sub group from which they are being transferred. 

3. Click on the OK button to initiate the move. 

Format Data Type 
This option displays the Format Data Type dialog that allows the user to 
change the units of measure for the different data types.  The user must select a 
logging function to access this feature and dialog.  

 
Format Data Type dialog 

DataAudit 
This option displays the Data Audit dialog that allows the user to search for 
missing or zero data within a logging function.  
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Data Audit dialog 

Perform an audit in the following way: 

1. Drag the items to audit into the DataAudit Selection window. 

2. Click on the Audit button. 

PrimeWorks generates an audit report in the lower window with the data 
colored based on the data type.  The Legend indicates the results that 
correspond to the colors. 

The user can resize the display to simplify the search for missing data by 
selecting the appropriate option from the Resize Display drop-down list.  
Adjust the size of the display based on the size of the gap under investigation.  
Select the period from the Error Period drop-down list to serve as the 
threshold at which PrimeWorks identifies a gap in the data as missing data on 
the display. 

Database Backup Log  
This option displays a report listing the PrimeWorks database daily backups 
that have been attempted and the corresponding results of those attempts.  It is 
enabled only if the user has configured the system to perform automatic 
backups and at least one log is available.    

Refer to Automatic Backup on page 21 for more information on setting up 
PrimeWorks to backup the database automatically each day. 
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 Mobile Device Menu 
The Mobile Device menu provides the following options for importing data 
from the user’s PDA or a remote location into the PrimeWorks database.  

 
Mobile Device menu options 

Import from PDA 
This menu option displays a dialog listing the sites available for import on the 
PDA, provided the link has been established between the user’s PC and the 
PDA.  

Import data from specific sites on the PDA to the PrimeWorks database by 
selecting the checkboxes on the dialog corresponding to the sites and then 
clicking on the OK button. 

Note:  When the same site exists both on the PDA and in the user’s 
database, PrimeWorks will incorporate the imported data into the 
corresponding site in the user’s PrimeWorks database. 

Import from Remote Location 
This option displays the Browse For Folder dialog through which the user can 
navigate to another PrimeWorks database containing data to import into the 
user’s PrimeWorks database.  

 
Browse For Folder dialog 
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Import the data by navigating to the directory location containing the other 
database, selecting the checkboxes corresponding to the sites containing data 
for import, and clicking on the OK button to initiate the import. 

Note:  When the same site exists in both databases, PrimeWorks will 
incorporate the imported data into the corresponding site in the user’s 
database. 
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 PrimeLog Menu 
The PrimeLog menu includes the following options:  

 
PrimeLog menu 

 Program  This option allows the user to program a logger. 

 Readback  This option allows the user to Readback data from a 
logger. 

 Pressure Autocal  This option sets the local barometric pressure as a 
reference instead of the factory default standard atmosphere setting (or 
the Autocal setting designated previously). 

 Reset  This option allows the user to prevent the logger from logging 
data, delete all data from the logger memory, delete site parameters, and 
restart the logger clock.  This function typically is used to reduce power 
consumption for storage purposes. 

 Automatic Dialing  This option controls the automatic dialing of 
loggers. 

 Modem Activity Log  This option opens the modem activity log. 
Refer to Chapter 6, PrimeLog Operation, on page 45 for more detailed 
information on PrimeLog. 
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Import/Export Menu 
The Import/Export menu provides the options for importing and exporting 
data to and from the PrimeWorks database.  The following import/export data 
type formats are available:  

 SERCK 

 Generic Date/Time stamping 

 SLI interface 

 
Import/Export menu options 

PrimeWare Import 
This option displays the PrimeWare Import dialog for importing data from 
PrimeWare databases.  

 
PrimeWare Import dialog 

Navigate to the appropriate site(s) and then designate the range of data to 
import.  Notice that the From and To fields automatically default to the earliest 
date/time and last date/time for the selected data items. 
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Automatic Export 
This option displays the Automatic Export dialog that allows the user to setup 
PrimeWorks to export data automatically.    

 
Automatic Export dialog 

Set up PrimeWorks to perform automatic exports in the following way: 

1. Drag and drop the location(s) to be exported into the Selected 
Locations window from the database navigation pane. 

2. Select the format for the output file from the Format drop-down list. 

 
Output file types 

3. Select the Browse button to navigate to and designate the path to which 
to export the data. 

4. Enter the appropriate suffix for the files in the Suffix field. 

5. Select the Enabled checkbox to ensure the automatic export feature is 
activated. 

6. Click on the OK button. 
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Any new data available in PrimeWorks will be exported automatically as 
designated by the selected parameters. 

Automatic Import 
This option displays the Automatic Import dialog that enables the user to set 
up PrimeWorks to import data automatically. 

 
Automatic Import dialog 

Set up PrimeWorks to perform automatic imports in the following way: 

1. Select the format in to import the data file from the Format drop-down 
list.  Typically, data is imported in a WINS/SLI File Format. 

2. Click on the Browse button to navigate to and designate the directory 
location from which to import the data files.  The selected location will 
display in the Path field. 

 
Browse For Folder dialog 
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3. Enter the extension(s) in the File field corresponding to the type of files 
to import from the designated directory location. 

4. Select the Enabled checkbox to ensure the automatic import feature is 
activated. 

5. Click on the OK button. 

Any new data files of the designated file type that appear in the selected 
directory location will be imported automatically into PrimeWorks and stored 
in an Imported PrimeWorks folder. 

Export Data 
This option displays the Export Data dialog for setting up an operation to 
export data from PrimeWorks.  From this dialog, the user can select the items 
to export, date/time range of the data, and output directory and file format. 

 
Export Data dialog 

Export data from PrimeWorks in the following way: 

1. Drag and drop the groups, sub groups, and loggers from which to export 
data from the database navigation pane to the Select Sample Dates 
dialog.   The items for export and the date/time range of data available 
for each item display in the window.   The following example shows two 
loggers. 
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Export Data dialog 

2. To export only a portion of the data available from a logger, modify the 
date/time range for each item in the following way: 

 Click on the pull-down arrow corresponding to the Start date/time 
for modification.  The date/time selection dialog displays, 
highlighting the date on which the earliest data is available in 
PrimeWorks. 

 

 Click on the desired start date.  Scroll through the months and years 
using the left and right arrows, as necessary. 

 Use the up and down arrows in the time field at the bottom of the 
dialog to designate the start time. 

 Close the date selection dialog once the start settings are complete. 

 Repeat the same process for the End date/time of the range. 

3. Select the format in which to export the data from the Format drop-
down list. 
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4. Verify that the directory location designated in the Output Directory 
section is the appropriate location to which to export the data.  
Designate another location in the following way:  

 Click on the Browse button.  The Browse For Folder dialog 
displays. 

 
Browse For Folder dialog 

 Navigate to the appropriate directory location in which to save the 
exported data files.  If necessary, create a new folder by clicking on 
the Make New Folder button. 

 Click on the OK button.  The file path displays in the Path field in 
the Output Directory section. 

5. Click on the Export button to initiate the export process. 

Import Data 
This option displays the Import Data dialog for setting up an operation to 
import data into PrimeWorks.  From this dialog, the user can select the format 
in which to import the data, the location from which to import the data, and the 
type of files to import.  
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Import Data dialog 

Import data into PrimeWorks in the following way: 

1. Select the format in which to import the data into PrimeWorks from the 
Format drop-down list. 

2. Click on the Browse button.  The Open dialog displays. 
3.  Navigate to the directory location in which the data files for import are 

currently stored. 

 
Open dialog 
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4. Select the files to import, and then click on the Open button.  The 
directory location from which the files will be imported displays in the 
Path field in the Selected File(s) section. 

5. Click on the Import button to initiate the import process.  Discontinue 
the data import process at any time by clicking on the Abort button. 

Edit Site IDs 
This option displays the Site IDs dialog for creating site reference IDs that may 
be used when exporting site data from PrimeWorks databases.  These IDs are 
not used within PrimeWorks.  However, they may be useful or essential during 
the export process to ensure greater flexibility or to compensate for issues such 
as file name limitations or reference requirements involving the export location.  

 
Site IDs dialog 

The user may create one site ID of up to 5 alpha numeric characters for each 
site in the database by entering the identification name in the field in the Site 
ID column corresponding to the Site Name. 
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Report Menu 

 
Report menu Reporting option 

The Report menu includes only the Reporting option.  

Reporting Option 
This option displays the Report dialog used for generating PrimeWorks data 
reports.  

 

For detailed information on generating reports, refer to Chapter 8, Reporting, 
on page 69. 
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Help Menu 
The Help menu includes three options:  

 Plug Info 

 About 

 Manual 

Plug Info 
This option displays the Help – Loaded Plugins dialog listing the Plugins 
installed in PrimeWorks and information related to each Plugin.  Click on the 
expansion symbol (+) on the tree corresponding to a specific item to reveal 
information about that item.  

 
Loaded Plugins dialog 
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About 
This option shows version, contact, and customer support information 
concerning the PrimeWorks software.  

 
About dialog 

Manual 
This option launches an electronic version of the ADS PrimeWorks User 
Manual. 
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C H A P T E R  5  

Toolbar 

This chapter provides detailed descriptions for the toolbar buttons and the find 
feature located directly beneath the main menu in PrimeWorks.  

 
PrimeWorks toolbar buttons 



 ADS PrimeWorks User Manual 

42 

 

Database Navigation Buttons 
The database navigation buttons perform tasks related to the database.  They 
can be used to add or remove a group, sub group, or a site.  

The database item selected determines the buttons that are available (enabled) 
for use to accomplish a particular function.  A disabled button indicates that the 
function corresponding to that button is not relevant or available for the selected 
item.  For example, a user cannot add a group to a sub group. 

Add and Delete Group Buttons 

 
Add Group and Delete Group buttons 

Clicking on the Add Group or Delete Group button adds/removes a group 
based on the selected position.  The user can rename a group by right-clicking 
on the group name and selecting the Rename option or by selecting the 
Rename Group option from the Database menu.  

Add and Delete Sub Group Buttons 

 
Add SubGroup and Delete SubGroup buttons 

Clicking on the Add SubGroup or Delete SubGroup button adds/removes a 
sub group based on the selected position.  The user can rename the sub group 
by right-clicking on the sub group name and selecting the Rename option or by 
selecting the Rename Sub Group option from the Database menu. 

 Add and Delete Site Buttons 

 
Add Site and Delete Site buttons 

Clicking on the Add Site or Delete Site button adds/removes a logger based on 
the selected position.  The user can rename a logger by right-clicking on the 
logger name and selecting the Rename option or by selecting the Rename Site 
option from the Database menu. 
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 Find Function 
The find function allows the user to search for a text string in the database 
navigation pane.  This function is useful particularly when a large number of 
groups, sub groups, and/or loggers exist in the database.  

 
Find functions 

Use the find text box and buttons to manage the find function.  To search for a 
text string, enter the text to be found into the text box and then click on the 
Search button ( ) to initiate the search.  Use the Search Previous and Search 
Next buttons ( , ) to search up and down the database hierarchy as 
necessary. 
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 Remove Logging Function 

 
Delete Logging Function button 

This button enables the user to delete a logging function.  Select the logging 
function for deletion, and then click on the Delete Logging Function button.  
Once the confirmation dialog displays, click on the OK button to delete the 
function.  Clicking on the Cancel button closes the dialog without deleting 
function.  

 
Logging function deletion confirmation dialog 
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C H A P T E R  6  

PrimeLog Operation 

PrimeLog is used to program loggers and/or read data from loggers.  This 
chapter describes how to use PrimeLog.  

Before using PrimeLog, the user must connect the logger to the serial port.  
Select the proper communication (com) port from the PrimeLog tab on the 
Properties dialog.  Refer to Port on page 19. 
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Program 
The Program option launches the PrimeLog Program dialog.  The PrimeLog 
Program function enables the user to program the logger with all the necessary 
parameters.  

This program is very flexible, allowing the user to load a data file, program a 
logger, read a logger, change the settings, save data to a file for future logger 
programming, and perform other essential tasks. 

 
PrimeLog Program window 

PrimeLog Program Buttons 
The buttons located at the bottom of the dialog perform the following functions:  

 New Config  Sets up a new configuration file 

 Load Config  Loads a saved configuration file 

 Save Config  Saves the configuration stored in memory to a file 

 Read Config  Reads the configuration of the logger 

 Program Now  Writes the program data to the logger 
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 New Config 
Selecting the New Config button displays the New Config dialog with a 
warning message indicating that creating a new configuration file eliminates 
any changes made since saving the configuration file.  To continue with the 
new configuration file, click on the Yes button; to abandon the new file, click 
on the No button. 

 
New Config dialog 

 Load Config 
Selecting the Load Config button displays the Browse For Folder dialog for 
navigating to a previously saved logger configuration file. 

 
Browse For Folder dialog 

After locating and selecting the file, click on the OK button to read the 
configuration file into the program.  Configuration files have the following 
filename format: [site name].setup.xml. 

 Save Config 
Selecting this button saves the configuration data currently stored in memory to 
a file.  PrimeWorks provides the file with the filename [site name].setup.xml 
and saves the file to a folder with the same site name.  The Save Config dialog 
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indicates the configuration has been successfully saved.  Click on the OK 
button to return to the main program. 

 
Save Config dialog 

 Read Config 
Selecting this button displays the Read Configuration dialog to enable the user 
to read data from the logger.  The logger must be connected to the PC’s serial 
port.   

 
Read Configuration dialog 

Clicking OK initiates the reading process and displays the Read Configuration 
window with a scrolling bar indicating the progress of the data reading process.   

 
Read Configuration progress window 

When reading is complete, the fields in the PrimeLog Program dialog will be 
populated with the data read from the logger. 

 Program Now 
Selecting this button displays the Program Logger dialog instructing the user 
to verify that the logger is connected to the PC serial port.   
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Program Logger dialog 

Once this connection is confirmed, click on the OK button to program the 
logger with the current settings. 

If the user attempts to program the logger before all the data is read back from 
the logger, PrimeWorks will display a warning. 

 
Readback Error dialog 

Clicking on the Yes button will program the logger without reading back some 
of the logged data stored in the logger.  This data will be lost.  Clicking on the 
No button will discontinue logger programming. 

Logger Clock 
The Logger Clock section on the Logger Information tab enables the user to 
configure the software to check the logger clock and synchronize it to the user’s 
PC clock when necessary or based on a user-defined difference.   

   
Logger Clock section on Logger Information  

A warning displays when the software detects a time difference between the PC 
and the logger clocks. 

Channel Parameters 
Selecting the Channel Information tab displays the channel data.  
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PrimeLog Program dialog (Channel Information tab) 

The Channel drop-down list on the Channel Information tab lists the 
channels available on the selected logger.  Two channel types are available: 
Analog and Digital.  The selected channel type determines the categories of 
logging that are available and the settings/parameters that display on the tab.    
For example, a user can log data from a bi-directional digital flow meter by 
selecting the appropriate meter type from the Digital 1a options.  A user can log 
uni-directional flows using two meters at independent locations in a single flow 
channel by selecting the meters separately from the Digital 1a and Digital 1b 
options. 

 Digital Screen Description 
Four types of logging are available through PrimeLog: 

 Flow Meter  This involves standard, periodic logging.  The other three 
are event-driven, recording the times at which pulses occur rather than 
the number of pulses. 

 Meter Type  Select the type of flow meter.  This is critical to 
ensuring the proper powering of the meter. 

 FCal  Enter/select the amount per pulse, and then select the units 
upon which the amount is based.  Refer to the Chapter 9, Appendix 
– Meter Scaling Tables, beginning on page 75, for the proper 
amount to enter. 
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 Flow Total Index  Enter the reading from the meter at installation 
so the total in PrimeLog will be consistent with the meter. 

 Low Flows  Select this checkbox if the meter will send less than 
one pulse per minute. 

 Logging Functions  Modify the logging function selection to 
setup the appropriate function.  Average & Total data can be logged 
independently. 

 Show Events  Select this checkbox to program the PrimeLog to 
record/provide notification based on internal (threshold) events or to 
trigger an output on the logger based on control output events. 

 Rain Gauge  This involves logging only when a specific amount of 
rainfall accumulates in a rain gauge tipping bucket.  The user must 
designate the amount of rainfall required to cause the tipping 
mechanism in the bucket to tip. 

 Pump  This involves logging only when a user-defined high or low 
indicates a pump is on or off.  The user also must designate the flow rate 
at which the pump turns on. 

 Overflow  This involves logging only when a user-defined high or low 
indicates an overflow state. 

 Analog Screen Description 
Select the type of sensor (Transducer/Voltage/Current). 

 Transducer  Enter the PCal for the transducer.  Select the Autozero 
on Program checkbox to remove the atmospheric offset when 
programming the logger. 

 Voltage  Enter the minimum scale and maximum scale values in user 
units and the offset in volts that the minimum scale represents. 

 Current  Enter the minimum scale and full scale values in user units 
and the offset in mA that the minimum scale represents. 

Note:  When using analog inputs on a PrimeLog, use the correct cable 
to connect to the logger source.  Current and voltage cables cannot be 
interchanged.  Improper use could cause internal damage to the logger. 
It also is important to use a voltage cable of the appropriate rating.  Do 
not apply a 10-volt source using a 2-volt or 5-volt cable.  This will 
overload the logger. 

The user can select an application for all analog sensors.  This will determine 
what is logged by the logger.  When using a depth transducer to measure open 
channel flow, both the depth and the derived flow will be saved during 
readback. 



 ADS PrimeWorks User Manual 

52 

 

Readback 
The Readback function enables the user to download data from a logger into the 
PrimeWorks database.  

Selecting the Readback option from the PrimeLog menu displays the 
PrimeLog Readback dialog.  Empty fields indicate that no data is available 
because readback has not yet occurred. 

 
PrimeLog Readback dialog 

The radio buttons on the dialog allow the user to designate whether to readback 
all or only a portion of the data from the logger: 

 Read All Data  Selecting this options reads back all data contained in 
the logger.  If the logger configuration has just been read, the range of 
data available in the logger will display in the start date/time and end 
date/time fields adjacent to the Read Data Between radio button. 

 Read Since Last  Selecting this option reads back all data since the 
last readback for the selected logger. 

 Read Data Between  Selecting this option allows the user to 
designate the date/time range for which to readback the data from the 
logger.  If the logger configuration has just been read, the range of data 
available in the logger will display in the corresponding start date/time 
and end date/time fields.  Designate the start and end dates/times using 
the data selection tool accessible by clicking on the down arrows 
associated with each date/time field. 

 Current Values 
Selecting this checkbox expands the dialog to reveal additional data fields.  
These fields are filled with current values from the data logger.  These values 
will update every 10 seconds. 
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Expanded PrimeLog Readback dialog 

 Readback 
Clicking on this button displays the Readback Confirmation dialog instructing 
the user to verify that the logger is connected to the PC serial port. 

 
Readback Data dialog 

Once this connection is confirmed, click on the OK button to initiate the 
readback process from the logger. 

A progress bar displays showing the status as data is read from the logger.  
Please note that large amounts of data may take additional time to readback. 

Once readback is complete and the designated data is added to the database, the 
data will display in the database navigation pane. 
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Pressure AutoCal 
The Pressure AutoCal function is used to set the local air pressure value as the 
reference for calibration.  By default, the calibration pressure is set to standard 
atmospheric pressure. 

Note:  To AutoCal a logger, the pressure connection pipe for the 
appropriate channel must be disconnected and the logger sensor must be 
open to the ambient air pressure that will be used as the calibration 
value. 

To run the AutoCal function, select the Pressure AutoCal option from the 
PrimeLog menu.  PrimeWorks opens the Read Configuration dialog 
instructing the user to verify that the logger is connected to the PC’s serial port. 

 
Read Configuration dialog 

Connect the logger to the serial port, and click on the OK button.  The progress 
will display in the lower right section of the main window. 

Once communication is complete, the Pressure AutoCal dialog will display. 

Note:  Autocal is available only for loggers recording data from 
pressure or depth transducers.  

The dialog displays the serial number, site name, and logger type.  Select the 
checkbox corresponding to the Sensor Information channel on which to 
perform the AutoCal process. 

Verify that the logger pressure transducer pipe is not connected to the logger, 
and then click on the AutoCal Now button to initiate the AutoCal process. 

Once the process is complete, an AutoZero Setting dialog will display the 
depth value representing the calibration factor that has been measured and set. 

 
AutoZero Setting dialog indicating a local zero value has been set 

Note:  Remember to reconnect the logger pressure measuring pipe as 
required. 
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Reset 
The Reset function resets the logger without affecting the database on the 
user’s PC.  It involves discontinuing any logging activities that may be 
occurring with the logger, deleting all data existing in the logger memory, 
deleting all site details, and restarting the logger clock.  This places the logger 
into storage mode, in which it consumes the least amount of power.  Resetting 
the logger essentially powers down and restarts the logger without re-
establishing the previous logger configuration. 
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Automatic Dialing 
This menu option displays the Automatic Dialing Setup dialog through which 
the user can configure PrimeWorks to call selected PSTN (public switched 
telephone network) sites automatically on a daily or weekly basis to readback 
data.  

 
Automatic Dialing Setup dialog 

Setup sites for automatic dial-up in the following way: 

1. Select and drag the site(s) for automatic dial-up from the database 
navigation pane on the main screen to the Automatic Dial Sites 
window on the Automatic Dialing Setup dialog. 

2. Choose the frequency at which to call the site(s) from one of the 
following options in the When to Dial section: 

 Daily  Select this radio button to dial the site(s) one time every day. 

 Weekly  Select this radio button to dial the site(s) once a week.  
Selecting this option enables the radio buttons representing the days 
of the week.  Choose the radio button corresponding to the day of the 
week to dial the site(s). 

3. Use the Time up and down arrows in the When to Dial section to 
designate the time at which to call the site(s) during the selected day(s). 

4. Select the Enable checkbox at the top of the dialog to ensure 
PrimeWorks calls the selected site(s) at the designated intervals and 
time following activation. 
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5. Select Resume to ensure that, if the automatic dialing process is 
terminated prematurely during a specific interval, PrimeWorks resumes 
calling sites at the next scheduled interval at the same point on the 
Automatic Dial Sites list at which the process was previously 
discontinued. 

6. (optional)  Select the Automatically Update Logger Time checkbox to 
ensure the PC automatically sets the logger clock during 
communication. 

7. Select the OK button to activate automatic dial-up based on the selected 
configuration. 

Once activated, AutoDial displays as a new icon in the user’s Windows taskbar. 
Passing the cursor over the icon displays the current status of AutoDial.  While 
AutoDial is in operation, the user cannot use PrimeWorks to call a logger 
manually. 
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 Modem Activity Log 
Selecting this option from the PrimeLog menu opens the Modem Activity Log 
dialog displaying all modem activity.  

 
Modem Activity Log dialog 

The user can clear the log by clicking on the Clear Log button. 
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C H A P T E R  7  

Graphing 

One of the primary features of PrimeWorks is producing graphs for visual 
analysis of logged data.  This capability includes several options, such as 
graphing multiple sources, scaling, selecting units, and printing.  

This chapter describes the process for creating or generating a graph, which 
essentially involves the following three stages: 

 Selecting the data 

 Generating the graph 

 Modifying the parameters (as required) 
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Selecting the Graph Data 
The data navigation pane contains all the data that is available for graphing.  
Select the exact source data to be graphed by highlighting an item in the pane at 
the appropriate level.  All items or data contained within (or under) that level in 
the data tree will be included on the graph.  
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Generating the Graph 
Once the appropriate item or database element at the desired level has been 
selected, right-click and select the Graph option from the menu.  The selected 
data displays in graphical format.  

The user can include additional elements in an existing graph by clicking and 
dragging them from the database navigation pane into the graph window. 

The graphing feature allows the user to graph either periodic logged data or 
event data.  For pump event data, PrimeWorks calculates the average flow and 
displays it adjacent to the events.  For rain gauge event data, PrimeWorks 
calculates the average and total rainfalls for display adjacent to the events. 

 
Logged data displayed in a graphical format 
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Modifying the Parameters for the Graph 
This section addresses the following topics concerning the modification of 
graph parameters:  

 Viewing area 

 Legend 

 Date/time range 

 Current trace 

 Query point (x and y values) 

Viewing Area 
Moving the cursor over the scale and title areas of the graph causes the cursor 
to change into a dot and arrow.  Clicking when the left, right, up, or down arrow 
and dot are shown moves the graph area in the direction of the cursor.  The 
scales re-calculate and display based on the movements. 

Clicking the maximize button on the graph window expands the graph to the 
maximum size and removes the window’s borders. 

Legend 
The Legend indicates the colors representing each trace on the graph and the 
parameters for the trace data.  When the graph includes more than 3 traces, the 
Legend window provides a scroll bar for scrolling through the colors and 
details of all the traces.  The user also can use the mouse wheel to scroll 
through the Legend window.  

 
Legend below graph display 

Increase the boldness of a trace by clicking on the appropriate trace on the 
Legend.  Right-clicking the trace name displays the following menu: 

 
Menu displayed when right-clicking a trace entry on the Legend 

Selecting one of the value options from the menu displays a line on the graph 
corresponding to that value for the selected trace.  Remove a trace from the 
graph by selecting the Remove option. 
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Start and End Times 

 
Start and End dates/times  

The Start and End fields at the top left of the graph display the starting and 
ending dates and times representing the range of data visible on the graph.  

Time Scale 

 
Time Scale drop-down list 

The Time Scale drop-down list located at the top right of the graph display 
contains the scaling options for displaying data on the graph.  The following 
options are available for selection from the list:  

 
Time Scale options 

Choosing the User Defined option enables the Start and End fields for 
modifying the range. 

 
Start and End fields and Time Scale drop-down list 

 Modifying the Start/End Date 
Modify the date in the Start or End field using the date selection dialog 
accessible by clicking on the down arrow in the corresponding field.  The date 
highlighted in the calendar represents the date displayed in the Start or End 
field. 

 
Date selection dialog 
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Select the appropriate date from the date selection dialog.  If necessary, scroll to 
another month and/or year using the right and left arrow buttons.  Select today’s 
date by clicking on Today: [current date] at the bottom of the dialog. 

Repeat this process for the other end of the date range as necessary. 

 Modifying the Start/End Time 
Modify the time in the Start or End field by highlighting the hour and/or 
minute in the corresponding field and then entering the desired value. 

Repeat this process for the other end of the time range as necessary. 

The selected start and end time apply only to the data being plotted.  Based on 
the selected values, the time axis may autoscale to show a slightly larger 
timescale. 

Control Bar 
The control bar displays below the Legend at the bottom of the graph. 

 
Control bar 

Note:  The Interval field and Save Data button are available only 
when graphing data derived from event data. 

 Interval 
Select the interval from the drop-down list over which to average the event 
data. 

 Save Data 
Click on this button to save the data after changing items on the graph. 

 Units 
Designate the units of measure to use for the data on the graph from this drop-
down list. 

 
Units drop-down list 
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 Show exclusively 
Select this checkbox to show only the highlighted trace from the Legend on the 
graph.  Leaving this box unselected displays all the traces on the graph. 

Overlay Button 
The overlay function allows the user to view data for a particular trace over 
different time periods on the same graph for comparison.  

To implement this function, click on the Overlay button at the bottom right 
below the graph. 

 
Graph showing the overlay feature 

On the overlay graph, click to the left and right of the top trace to shift it within 
the graph for comparison of the traces.  The corresponding timescale also 
moves to show the relative times of the traces. 

 
Moving the trace for comparison 
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Right-Click Menu (Graph) 
Right-clicking on the graph displays the following menu options: 

 
Right-click menu 

 Zoom In 
Selecting this option shifts the cursor into zoom mode, allowing the user to 
click and drag a section on the graph into which to zoom.  Once the mouse 
button is released, the graph will automatically zoom into that designated 
region.  This option performs the same function as clicking on the zoom button.  

 Zoom Out 
Selecting this option undos the most recent zoom on the graph.  It performs the 
same function as clicking on the zoom out button.  

 Restore 
Selecting this option restores the original graph display.  It performs the same 
function as clicking on the full view button. 

 Insert Text 
Selecting this option creates a text box on the graph.  The user can add/edit text 
as required, modify the shape of the text box, and move the text box around 
using standard Windows editing features.  
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Right-clicking on a text box allows the user to attach a comment to a specific 
point on the graph.  When the graph is closed, PrimeWorks will save the 
comment to the file so that it will display again the next time the user graphs the 
data. 

 Print 
Selecting this option prints out the current graph.  

 Print Preview 
Selecting this option displays a printable version of the graph on screen based 
on the current settings. 

 Properties 
Selecting this option displays the Properties dialog, which includes several 
tabs containing features that allow the user to modify the presentation and 
structure of the graphs.  

 Graph Tab 

 
Properties dialog (Graph tab) 

The Graph tab enables the user to designate various graphing parameters, 
including titles and colors.  Only the color of the current trace can be changed.  
To change the color of other traces, close the Properties dialog, select other 
data, and re-open the Properties dialog. 

One Property tab is available for each axis displayed on the graph. 
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 Average Axis 

 
Properties dialog (Average [trace name] Axis tab) 

PrimeWorks provides three options for scaling the axis: 

 Autoscale  Selecting this option allows the software to select the best 
fit. 

 Fixed Zero  Selecting this option designates the lower limit of the axis 
as zero and autoscales the higher limit of the axis. 

 Manual Scaling  Selecting this option enables the corresponding Min 
and Max fields to allow the user to designate both the upper and lower 
limits manually. 

Select the Threshold checkbox to display a line representing a threshold on the 
graph based on a user-defined value.   

Choose the color for the axis on the graph from the Axis Color drop-down list. 
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C H A P T E R  8  

Reporting 

PrimeWorks enables the user to generate, view, and print out reports of logged 
data.  This chapter describes the process for producing reports, which primarily 
involves four stages:  

 Selecting the data 

 Designating the parameters 

 Generating the report 
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Selecting the Data 
The first step involved in generating a report is selecting the data to include in 
the report.  Select the data for the report from the appropriate level in the 
database navigation pane, right-click on the item, and select the Report option 
from the menu.  This displays the Report dialog.  

The user may select other items from the navigation pane while the report 
dialog is open, and PrimeWorks will add those items to the report.  However, 
to start a new report, first close the open Report dialog. 
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Designating the Parameters 
The Report dialog displays the items currently selected for the report and the 
default start date/time and the end date/time.  The default start and end dates 
and times represent the range of data currently available for the selected 
item(s).  The user can modify the date and time range for the report from these 
fields.  

 
Report dialog 

To modify the report date and/or time range, click on the down arrow 
corresponding to the Start or End field to display the date selection dialog. 

 
Date selection dialog 

Select the appropriate date from the date selection dialog.  A user can select 
dates only for which data is available.  To select today’s date, click on Today: 
[current date].  If necessary, use the right and left arrow buttons to scroll 
through the calendar to select a date in another month and/or year. 

Designate the appropriate time from the time field at the bottom of the date 
selection dialog.  For each hour, minute, or second, select the corresponding 
field and enter the appropriate value or use the up and down arrows to scroll to 
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the appropriate number.  Once date and time selection is complete, close the 
date selection dialog.   

Repeat this process for the other end of the range, when necessary. 

Select the type of report to generate from the Format drop-down list at the 
bottom of the Report dialog. 
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 Generating the Report 
To generate the report based on the selected parameters, click on the Generate 
button.  

 
Example of a Daily Statistics Report 

The kind of data posted on the report varies based on the report type (format) 
generated.  Some of the most common information provided on reports includes 
the site name, date/time, channel, event type, minimum/maximum values, 
average values, and threshold.  Some reports also include options for filtering 
report results based on event types. 
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Appendix – Meter Scaling Tables 

This appendix contains scaling tables for the following kinds of meters:  

 Elster/Kent Helix & Domestic Meters 

 Schlumberger/Actaris/Stream Domestic & Helix Meters 

 Sensus (Socam/Meinecke) Meters 

Note:  To obtain the scaling tables for other meters, please contact the 
ADS support center. 
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Elster/Kent Helix & Domestic Meters 
Meter PU10/LRP PU100/HRP 

 (mm) FCAL 

Helix 2000 
40-80 10 1 

100-300 100 10 

Helix 3000 

40-80 10 1 

100 10 1 

150 100 10 

Master 2000 
40-50 1 0.1 

80-100 10 1 

 PVG100 PV14/BPG20 

Helix 4000 
80-125 10/1000 1 

150-300 100/10000 10 

 PSM MSM 
PSM-PS15-PS20 
(V100) 

15/20 0.5  

PSM-PS25-PS30 
(V100) 

25-30 5  

PSM-PS40 (V100) 40 5  

PSM-LT (V210) 15 & 20 0.5  

MSM-T (V100)   1 

KVM-T (V200)   1 

MSM-RS   10 

Supplementary Notes: 

FCAL = NUMBER OF LITERS PER PULSE 

Kent Meters: 

* Some earlier 100-mm meters require the following: 

FCAL = 100(PU10/LRP) or 10(PU100/HRP). These meters can be distinguished by the center 
pointer dial registration = 1000 liters/rev. 

** Applies to 7-digit counters only.  The other FCALs apply to the 8-digit counters. 

Kent combination meters use a Helix 3000 meter as the main meter and a PSM-T as the secondary 
meter.  Select the appropriate FCAL from the table above for each of the meters. 

The Master 2000 meter has been discontinued. 
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Schlumberger/Actaris/Stream Domestic & Helix 
Meters 

Meter CYBLE HF CYBLE LF 
 (mm) K=1 K=2.5 K=10 K=25 
Aquadis 
(4X4) 

15 0.1 0.25 1 2.5 

Aquadis 15-40 1 2.5 10 25 

P40M (4x4) 15 0.1 0.25 1 2.5 

P40M 15 1 2.5 10 25 

FlostarM 40-100 10 25 100 250 

Woltex 

50-100 10 25 100 250 

150-300 100 250 1000 2500 

400-500 1000 2500 10000 25000 



 ADS PrimeWorks User Manual 

78 

 

Sensus (Socam/Meinecke) 
Meter K510 K505R 

 (mm) FCAL 
510/510PR 

15-20 

1 

0.5 
501L 10 

501LM 100 

501JM 1000 

510/510PR 
25-30 

10 
5 

501JM 100 

 R01.1 OPTO 06 

Cosmosil 

50-125 100/1000 1 

150-250 1000/10000 10 

300-800 10000/100000 100 

 RD 01 OD 07 
Cosmos 50-125 100 

1 

WP/WS-Dynamic 

40-125 
100/1000 

10/1000 

150-300 
1000/10000 

10 
100/10000 

Supplementary Notes: 

FCAL = NUMBER OF LITERS PER PULSE 

Socam meters: 

*The 510 pulse unit is factory fitted and cannot be removed.  The FCAL is determined at the factory 
and the table above shows the values available.  Check the individual meter before selecting the 
appropriate FCAL.  
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Index 

A 
about, 39 
automatic backup, 21 
automatic dialing, 56 
automatic export, 30 
automatic import, 31 

B 
buttons, 41 

application window, 12 

C 
creating a graph, 59 

D 
database backup log, 25 
database menu, 22 

bulk move, 23 
data audit, 24 
delete, 23 
format data type, 24 
rename, 23 

database navigation pane, 9, 16 
toolbar buttons, 42 

E 
edit site IDs, 36 
exit, 21 
export 

automatic, 30 
export data, 32 

F 
file menu, 13 
find function, 43 

G 
generating a graph, 61 
generating a report, 73 

graphs, 59 
date/time range, 63 
inserting text, 66 
generating the graph, 61 
legend, 62 
modifying parameters, 62 
overlay, 65 
page setup, 14 
printing, 67 
properties, 17, 67 
selecting data, 60 
time scale, 63 
zooming in, 66 
zooming out, 66 

H 
hardware requirements, 4 
help 

about, 39 
plugins, 38 

help menu, 38 

I 
import data, 34 

automatic, 31 
PDA, 26 
remote location, 26 

import/export menu, 29 
installing PrimeWorks, 3, 5 
interface overview, 7 

K 
Kent Meters, 76 

M 
main window, 8 
menus, 11 
menus, 8 

database, 22 
file menu, 13 
help, 38 
import/export, 29 
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mobile device, 26 
PrimeLog, 28, 45 
report, 37 

messages, 16 
meter scaling tables, 75 

Master Meters, 76 
Schlumberger/Actaris/Stream 

Domestic & Helix Meters, 
77 

Sensus (Socam/Meinecke), 78 
mobile device menu, 26 

import from PDA, 26 
import from remote location, 

26 
modem, 19 
modem activity log, 58 

O 
overview, 1 

P 
page setup 

graphs, 14 
reports, 14 

PDA, 26 
plugins, 38 
pressure AutoCal, 54 
PrimeLog menu, 28, 45 

automatic dialing, 56 
modem activity log, 58 
pressure AutoCal, 54 
program 
readback, 52 
reset, 55 

PrimeLog, 19 
channel parameters, 49 
logger clock, 49 
operation, 45 
port, 19 

PrimeProbe2, 20 
PrimeWare Import, 29 
PrimeWorks 

installation, 3, 5 
interface, 7 
overview, 1 

print, 13 
print preview, 13 

programming PrimeLog, 46 
buttons, 46 
channel parameters, 49 
logger clock, 49 

properties, 16 

R 
readback, 52 
receiving alarm calls, 20 
report menu, 37 
reporting, 37, 69 

designating parameters, 71 
generating the report, 73 
page setup, 14 
selecting data, 70 

resetting loggers, 55 

S 
scaling tables, 75 
search, 43 
site IDs, 36 
SMS messaging, 18 
Socam meters, 78 
software requirements, 4 

T 
technical support, 2 
toolbar, 8 

buttons, 41 
database navigation, 42 
delete logging function, 44 
find function, 43 

U 
user access requirements, 4 

V 
version, 39 
view, 15 

W 
wireless communication 

properties, 18 
working/viewing pane, 10 
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